EJ’XOSTAR Exostar LDAP ProxXySecureEmait, SetupGuide

This document provides information on the following topics:

Email Encryption saip ¢ Outlook 2003

Email Encryption saip ¢ Outlook2007

EmailEncryption seup ¢ Outlook 2010

Email Encryption saip ¢ Outlook 2013

Certificate Discoverg Outlook 2003

Certificate discoverg Outlook 200

Certificate discoverg Outlook 2010

Certificate discoverg Outlook 2013

= =4 =4 A4 A4 A A A -

Boeing Certificate download

Please note:

1. Itis recommended that bothriail En“cryption setup andCertificate Discovery“stepare
completed toenable uses2 ¥ 9 E 2 & (i I NAB&curgBnhiltservichsR E &

2./ SNIATFTAOFI(GS 5A32020SNE NBljdZANBa O2yySOiGAz2Yy
this may require additional configuration by customer IT infrastructure groups
dependingon local policy & controls.

3. For Lotus Notes and Mozilla Thunderbird, contact Exostar via the Custonbepedite
with information on the email client version
http://www.myexostar.com/contactSupport.aspx
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Email Encryptiorset-up ¢ Outlook 2003

Open Outlook 2003

1. SelectToolsfrom menu

2. SelectOptionsfrom drop down menu

3. Indialog box that appears selesecuritytab

4. Enter a name for your security setting into tBecurity Settings NambBox

5. EnsureS/MIME is selected on the Secure Message Format box

6. Check theDefault Security Settindor this Secure Message Format

7. InCertificates and Algorithmsection click the&Chocsebutton in the Signing Certificate
section

8. Select your Secure Email Certificate from 8wdect Certificatalialog box

9. Outlook should automatically choose the sa®ecure Email Certificates your Signing
Certificate for the email Encryption Certifieatf not, click theChoosebutton in the
Encryption Certificate and select your Secure Email Certificate from the Select
Certificate dialog box

10. EnsureSend These Certificates with Signed Messageselected

11. ClickOKto return to Optionsdialog box

12. Clck OKto return to Outlook

Digitally signing an email:

1. Compose your email and attach files as usual

2. ClickSign Ebutton
3. ClickSendbutton

If you receive an error message at this time, you may want to configure LDAP Proxy settings to
enable certificate discovery. Follow information in sectiGertificate Discoverg Outlook 2003.
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Email Encryptio set-up ¢ Outlook 2007

Open Outlook 2007

1. SelectTools/Trust Centefrom menu
2. SelectEmail Securityrom left hand navigation

Trusted Publish
rusted Publishers Sl

Add-ins
gE_ |:| Encrypt contents and attachments for outgoing messages

Privacy Options Add digital signature to outgoing messages

Send clear text signed message when sending signed messages
[ Request S/MIME receipt for all 5/MIME signed messages

Default Setting: |Outga|ng emall V‘ [ Settings...

TE-mail Security . "“"|

Attachment Handling

Automatic Download

Digital IDs (Certificates)
Macra Security

~-| Digital IDs or Certificates are documents that allow you to prove your identity in electranic transactions,
Programmatic Access
| Publish to GAL.. | | Import/Export... | | Get a Digital ID..
Read as Plain Text

[] read all standard mail in plain text

Script in Folders

|:| Allow script in shared falders
Allow script in Public Folders

3. To send encrypted or digitally signed email, select the appropriate option under
Encrypted Email. In the screenshot abowely digital signature is checked. Check

9YONR LI O2yiSyia X bpdefalByR 'y SYyONBLIWISR SY

Underdefault setting, selectoutgoing email
Click onSettingsbutton

SN
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Change Security Settings ﬁ|

Security Setting Preferences

Security Setkings Marme:

Dukgaing email v |
Cryprography Format: | 5/MIME v |

Defaulk Security Setting For this cryptographic message Format
Defaulk Security Setting For all cryptographic messages

[SEcgriI:*;.-' Labels... ] [ Tl ] [ Delete ]

Cettificates and Algarithms

Signing Certificate:

Hash Algorithm: AL & |
Encryption Certificate: |=ccrc copie -m
Encryption Algorithrm: [ 3DES W

Send these certificates with signed messages

Ik l [ Cancel

6. You may see that your signing certificate is already selected (for digigtiyng the
SYFAfTOD ¢2 SyadaNBE GKFEG O2NNBOG OSNIATFAONGS
appropriate certificate. Make sure that the Hash algorithm is SHAL.

7. For Encryption certificates, follow step #6 and ensure that the Encryption algorithm
selectal is 3DES.

8. Click OK.

Digitally signing an email:

1. Compose your email and attach files as usual

2. ClickSign Ebutton
3. ClickSendbutton

If you receive an error message at this time, you may want to configure LDAP Proxy settings to
enable certificate discovery. Follow information in sectiGertificate discoverg Outlook 2007
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EmailEncryption setup ¢ Outlook 2010

Open Outlook 2010

SelectFiletab from the top left
SelectOptionsfrom left hand navigation
SelectTrust Centerfrom left hand navigation
Click onTrust Center Settingbutton
Selectemail Securityfrom left handnavigation

arwnNPRE

-
Trust Center l & —

Trusted Publishers

Encrypted e-mail

DEFP Settings
9‘5 Encrypt contents and attachments for outgoing messages
£

Add digital signature to outgoing messages
Send clear text signed message when sending signed messages
|:| Request 5/MIME receipt for all 5/MIME signed messages

Attach t Handli
achment Handling Default Setting: | My S/MIME Settings [PauI.Haynes@exostar.com]El

Automatic Download

Privacy Options

[ E-mail Security ]

Digital IDs (Certificates)
Macro Settings

= | Digital IDs or Certificates are documents that allow you to prove your identity in electronic transactions,

Programmatic Access
| Publishto GAL... | | Import/Export... | | Geta Digital ID..

Read as Plain Text

|:| Read all standard mail in plain text
Read all digitally signed mail in plain text

Script in Folders

|:| Allow script in shared folders
Allow script in Public Folders

[ OK ] [ Cancel

6. To send encrypted or digitally signed email, select the appropriate optinder

Encrypted Emil. In the screenshot above, Check Encrypt contents, Add digital signature
andSendcleartext 42 &aSyR 'y SyYyONRBLIWISR SYIAf ®
Underdefault setting, selectMy S/MIME Settings (User name)

8. Click onSettingsbutton

~
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[ Change Secunty Settings @1

Security Setting Preferences

Security Settings Mame:
My 5/MIME Settings (Paul.Haynes@exostar.com) -

Cryptography Eormat: | 5/MIME

Default Security Setting for this cryptographic message format
Default Security Setting for all cryptographic messages

[Secgrity' Labels...] [ Mew ] [ Delete ] Password...

Certificates and Algarithms

Signing Certificate: Paul Haynes_2535(Signature)

Hash Algorithm: [SHA 1 - ]

Encyption Certificate: |Paul Haynes_9535(Encryption) Choose...

Encryption Algorithm: [EDES v]

send these certificates with signed messages

[ oK ][ Cancel ]

9. You may see that your signing certificate is already selected (for digitally signing the

SYFAfTOD ¢2 SyadaNB GKFEG O2NNBOG OSNIAFAONGS

appropriatecertificate. Make sure that the Hash algorithm is SHA1

10. For Encryption certificates, follow step #9 and ensure that the Encryption algorithm
selected is 3DES

11. Click OK.

Digitally signing and encrypting a@mail:

1. Qeate and ompose your email and attach files as usual

2. Click theOptionstab at the top

3. Inthe options ribbon markeBermissiorclick oneitherthe Encrypticonto encrypt the
message or th&igniconto digitally sign the message or both if you choose. See below.

Copyright©2013 Exostar LLC. All rights reserved Page6 of 26



EXOSTAR"

Exostar LDAP ProxXySecureEmait, SetupGuide

F N
| = O Untitled - Message (HTML) = | B [t
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Themes Page Bcc  From | Permission 3 sign Use Vating [ Request a Read Receipt 5ave 5ent Delay Direct
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To..
-
=1 ce.
Send i
Subject:

meEy|

>

4. To send Encrypted email requires the recipients public encryption key (Digital
Certificate). MS Outlook will need to be configured for certificate discovery or users will
need to exchange digitally signed email first to exchange public encryption keys.

5. ClickSendbutton as usual to send email.

If you receive an error message at this time, you may want to configure LDAP Proxy settings to
enable certificate discovery. Follow information in sectiGertificatediscoveryc Outlook 2010
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Email Encryptn setup ¢ Outlook 2013

Open Outlook 2013

SelectFiletab from the top left

SelectOptionsfrom left hand navigation

SelectTrust Centerfrom left hand navigation

Click onTrust Center Settingbutton

Selectemail Securityfrom left hand navigatiomnd the below screenshot will appear

arwnNPRE

Trust Center @I&J

Trusted Publishers

Encrypted e-mail

Privacy Options
[] Encrypt contents and attachments for outgoing messages

Em=l R : [] Add digital signature to outgoing messages

Attachment Handling [7] Send clear text signed message when sending signed messages
Automatic Download [] Request S/MIME receipt for all 5/MIME signed messages

Macro Settings Default Setting:
Programmatic Access Digital IDs (Certificates)

| Digital IDs or Certificates are documents that allow you to prove your identity in electronic transactions.
[ Bublish to GAL... | [ Import/Bxport... | [ Get a DigitalID...

Read as Plain Text

[] Read all standard mail in plain text

Read all digitally signed mail in plain text

Script in Folders I

[ Allow script in shared folders
[ Allow script in Public Folders

CEI"I CEI

6. Click onSettingsbutton and the screenshot below will appear

Copyright©2013 Exostar LLC. All rights reserved Page8 of 26



EJ’XOSTAR Exostar LDAP ProXySecureEmait, SetupGuide

Change Security Settings

S5

Security Setting Preferences

Security Settings Mame:

S/MIME Settings (Paul.Haynes@exostar.com

Cryptography Format: | 5/MIME
I Default Security Setting for this cryptographic message format

Default Security Setting for all cryptographic messages

[Securit].rLabeIs...] [ MNew ] [ Delete ]

Certificates and Algorithms

Hash Algorithm: | sHAL -|

Encryption Algorithm: |3DES -|

Send these certificates with signed messages

Signing Certificate: Paul Haynes_9535(5ignature]
Encryption Certificate: |Paul Haynes_9535(Encryption]

[ 0K ][ Cancel ]

7. You may see that your signing certificate is already selected (for digitally signing the

SYFAfTOD ¢2 SyadaNB GKI G

O2 NNEB O

appropriate certificate. Make sure that the Hash algorithm is SHA1
8. For Encrypbn certificates, follow step #@nd ensure that the Encryption algorithm

selected is 3DES
9. ClckOK

OSNIAFAOLKGS
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.
Trust Center l T

Trusted Publishers

Encrypted e-mail

Privacy Opticns

Q‘ﬂ Encrypt contents and attachments for outgoing messages
1

E-mail Security Add digital signature to outgoing messages
Attachment Handling Send clear text signed message when sending signed messages
Automatic Download [] Request S/MIME receipt for all 5/MIME signed messages

Macro Settings Default Setting: | My S/MIME Settings (Paul. Haynes@ exostar.com) EI

Programmatic Access Digital IDs (Certificates)

= | Digital IDs or Certificates are documents that allow you to prove your identity in electronic transactions.
| Publish to GAL.. | | Import/Export... | | Geta Digital ID...

Read as Plain Text

[] Read all standard mail in plain text

Read all digitally signed mail in plain text
Script in Folders [

] Allow script in shared folders
Allow script in Public Eolders

[ ok || cancel |

10.To send encrypted or digitally signed email, select the appropriate options under
Encrypted Email. In the screenshot above, Check Encrypt contents, Add digital signature
FYR {SyR Ot SINJGSEGX G2 aSyR Iy SyONEBLIiSR
11.Underdefault setting, selectMy S/IMIME Settings (User name)
12. ClickOkto finish.

Digitally signing and encrypting a@mail:

1. Qeate and ompose your email and attach files as usual

2. Click theOptionstab at the top

3. Inthe options ribbon marke®ermissiorclick on either theEncrypticon to encrypt the
message or th&ignicon to digitally sign the message or both if you choose. See below.
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E H = Untitled - Message (HTML) ? B - O %
MESSAGE INSERT OPTIONS FORMAT TEXT REVIEW
j Caolors - i | i=e o0 ) ] 7 o ®
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4. To send Encrypted email requires the recipients public encryption key (Digital
Certificate). MS Outlook will need to be configured fertificate discovery or users will
need to exchange digitally signed email first to exchange public encryption keys.

5. ClickSendbutton as usual to send email.

If you receive an error message at this time, you may want to configure LDAP Proxy settings to
enable certificate discovery. Follow information in secti@ertificate discoverg Outlook 2013
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Cerificate Discovenc Outlook 2003

1. Open your Microsoft Outlook.
2. Select Tools>Email Accounts

3. {StSO00G WIRR I yS6 RANBOOHENE Q2N | RRNB &
4. { St SOG WLYGSNYySi SWHNSE@ENE { SNBAOSQ |
5. 9y iSNI GKS 9YyONRLIIAZ2Y [/ SNIAFTAOLGS [22]
Idapproxy.exostar.com
Diregtory Sewvioe (LIMF) Setiings
Wipdj can enber the reguires settings to sooess mformaton inoa deechory service
Server ndosmstsoen
Tyt tha P off ol e xRy’ frveer iy Sorall fabrvitn priveicler o dyibii St st or
hae et e
e e | |
[EEE T s
[ This pewrven sespares s b kg o
[_corca ]
Restart Outlook for the changes take effect.
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Certificate Discoverg Outlook 2007

1. Open your Microsoft Outlook.
2. Select Tools>Account Settings>Address Books to display the following screen.

@& Inbox - Microsoft Outlook

i File

Favorite Folders
Mail Folders
£ ANl Mail Trems

=] @ Mailbox - Seema Gupta
(&) Deleted Items (15}
(7| Drafts [5]

=[5 Inbox (14)

% RSS Feeds

= Sent Items

# L@ Search Folders
# 5 Archive Folders
= £ Archive Folders
# (5 Deleted tems
= 3 Inbox

Outlook Connector

Help

Type a question for help H

¥ N To-DoBar » =

= | < October 2009
Account Settings m SM TW T F
1 2
Directories and Address Books 1 5 6 7 & 91
‘ou can choase a directary or address book below ko change or remove it 11 13 14 15 16 1
18 19 20 21 22 23 2
25 26 27 28 29 30 3

E-mail ” [Drata Files || R35 Feeds || SharePaint Lists || Inkernet Calendars || Published Calendarsl Address Books

[ Customer Service (29)
# [ ForumPass

[ ForumPass access

[ Important to do

3 RRISSUES (1]

[ RRGSPFIS Agreements

Directory or Address Book Type
‘You can choose the bype of directary or address book you'd like to add.

Reservation at Courtyar
9:00 PN - Tue 10:30 AM
638 Hillsdale Drive Charl

Take flax seed capsule
:00 PM -9:00 PM
Shantanu Sharma & @

Appointment with Dr. Gi

[ Timesheet (1)
[ g Junk E-mail (4]
[ Outbox [1]

3 SIG EMAILS

[ Action required
[ ForumPass

information,
ma

(%) Internet Directory Service (LDAP)
Conneck to an LDAP server to find and verify e-mail addresses and other

() Additional Address Books

Connect to an address book to Find and verify e-mail addresses and other

information.

Tue 11:15 AM - 12:30 PM

P | 1300 Jefferson Park Ave,

Arranged By: Due‘..l =
I Type a new task I

¥ Today

L mall L
5] calendar
|8Z] contacts
/] Tasks
el 3@ -

3. { St SO
screen below.

WLYGSNYS

7

i

5

[ o

5ANBOG2NE

= O

{ SNIA OS

r

(0]

[ 51t
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Diregtory Sewvioe (LIMF) Setiings
W) Can enker Hee reguinsd settings to sooess nformation in s deechory searvios.

Server ndosmstsoen

Tyt tha P off ol e xRy’ frveer iy Sorall fabrvitn priveicler o dyibii St st or
e greri P

Server Hawe! |
Lo Nribommriaation

[ Thek sawees secpures ma b b o

4. Enter the following information:
Server InformationURL: Idapproxy.exostar.com

a. Click on More Settings

Add New E-miail Account x|

Directory Service {LDAP) Settings
You can enker the required settings to access information in a direckary service,

Server Information

Type the name of the directory server wour Internet service provider or syskem adminiskrakar
has given you,

Jerver Mame: |dapprosey . exostar, com

Logon Information

[ This server requires me to log on

Iser Mame; I

Fasswond: I

™| Require Secure Password suthentication (SR
Mare Setkings ...

< Back Mext = Cancel
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b. You will be provided a warning message to close Outlo@ictivate the new
settings Click OK.

Add E-mail Account x|

i i The E-mail Account you have just added will nok skart until vou choose Exit from the File menu, and then restart
Microsoft Office Cutlook,

c. Click OK. The following completioressage will be presented. Click Finish and
close Outlook.

Add New E-mail Account

Congratulations!

¥ou have successfully entered all the information required ko setup your
account,

To close the wizard, click Finish,

-

d. Restart Outlook to send encrypted email.
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Certificate Discoverg Outlook 2010

Open your Microsoft Outlook

SelectFiletab from the top left

SelectAccount Settingscon and then click oAccount Settings
SelectAddress Bookab as per screenshot below

-
Account Settings ﬁ

Directories and Address Books
You can choose a directory or address book below to change or remove it.

Hwn e

[ New... P57 Change...

Mame Type
Outlook Address Book MAPT

Close

5. Select theNewicon to the left hand side
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Add New Account &J

Directory or Address Book Type
¥ou can choose the type of directory or address book you'd like to add.

@ iInternet Directory Service (LDAP)
Connect to an LDAP server to find and verify e-mail addresses and other
information.

") Additional Address Books

Connect to an address book to find and verify e-mail addresses and other
information.

6. { S{ Bteriet Ditectory Service (LDAR) | & KA IKE{ ATIKISR | 6020So

screen below.

g ™
Add New Account - &J

Directory Service (LDAP) Settings
You can enter the required settings to access information in a directory service.

Server Information

Type the name of the directory server your Internet service provider or system administrator
|| has given you.

Server Mame: |

Logon Information

[ This server requires me to log on

Reguire Secure Password Authentication (SPA)

More Settings ...

Copyright©2013 Exostar LLC. All rights reserved
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7. Enter the following information:

Server NameURL: Idapproxy.exostar.com

r A
Add Mew Account - &J

Directory Service (LDAP) Settings
¥ou can enter the required settings to access information in a directory service.

Server Information

Type the name of the directory server your Internet service provider or system administrator
|| has given you.

Server MName: URL: ldapproxy.exostar.com|

Logon Information

[] This server requires me to log on

Reguire Secure Password Authentication (SPA)

Mare Settings ...

< Back ][ Mext = ][ Cancel

8. Click orMore Settings
9. You will be provided with a warning message to restart Outlook to activate the new
settings. ClickOK

F - e aae e - ™
Add E-mail Account |

:I You must restart Outlook for these changes to take effect.

10. The following pop up screen will appear.
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11. ClickOK
12.The below screen will appear agaiick onNext
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